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Using the NFC feature

The NFC(Near Field Communication) printer allows you to directly print from 
your cellphone just by holding your cellphone over the NFC tag on your printer. 
It does not require installing print driver or connecting to an access point. You 
just need NFC supported cellphone. In order to use this feature, Samsung 

Mobile Print app needs to be installed on your cellphone. 

 

• Depending on the material of the mobile device cover, NFC recognition may not work 
properly. 

• Depending on the mobile device you are using, the transmission speed may differ.

• This feature is available only for the model with a NFC tag (see "Machine overview" on 
page 15). 

• Using a cover or a battery other than the ones that came with the mobile device, or 
a metal cover/sticker can block NFC.

• If NFC devices keep failing to communicate, remove and reinstall the battery from the 
mobile device, then try again.
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Requirements

• NFC and Wi-Fi Direct enabled, Samsung Mobile Print app installed mobile 
device with Android OS 4.0 or higher. 

 

Only Android OS 4.1 or higher will automatically enable the Wi-Fi Direct 
feature on your mobile device when you enable the NFC feature. We 
recommend you to upgrade your mobile device to Android OS 4.1 or higher 
to use the NFC feature.

 

• Wi-Fi Direct feature enabled printer (see "Setting up Wi-Fi Direct" on page 
161).



Using the NFC feature
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Printing

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer (see "Setting 
the Wi-Fi Direct for mobile printing" on page 161). 

2 Tag the NFC tag on your mobile device (usually located on the back of 
the mobile device) over the NFC tag( ) on your printer.

Wait few seconds for the Samsung Mobile Print app to start.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

• If your do not have Samsung Mobile Print app installed on your mobile 
devices, it automatically connects to Samsung Mobile Print app 
download page. Download the app and try again.

 

3 Select print mode.

4 Select the content you want to print.

If necessary, change the print option by pressing the 

5 Tag the NFC tag on your mobile device (usually located on the back of 
the mobile device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

 

6 The printer starts printing.
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AirPrint

 

Only AirPrint certified machines can use the AirPrint feature. Check the box 
your machine came in for the AirPrint certified mark.
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Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
AirPrint feature. You can enable the AirPrint feature by one of the following 
methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the SyncThru™ Web Service website.

4 Type in the ID and Password, then click Login. Type in the below default 
ID and password. We recommend you to change the default password 
for security reasons.

• ID: admin 

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings.

6 Click Raw TCP/IP, LPR, IPP or mDNS .

You can enable the IPP protocol or mDNS protocol.
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Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.

AirPrint allows you to wirelessly print directly from iPhone, iPad and 
iPod touch running the latest version of iOS.
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Cancelling print job: To cancel the printing job or view the print summary, 

click the print center icon ( ) in multitasking area. You can click cancel in 

the print center.
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Google Cloud Print™

Google Cloud Print™ is a service that allows you to print to a printer using your 

smart phone, tablet, or any other web-connected devices. Just register your 
Google account with the printer, and you are ready to use the Google Cloud 
Print™ service. You can print your document or email with Chrome OS, Chrome 
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you 

don’t need to install the printer driver on the mobile device. Refer to the Google 
website (http://www.google.com/cloudprint/learn/ or http://
support.google.com/cloudprint) for more information about Google Cloud 
Print™.
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Registering your Google account to the printer

Registering from Samsung Mobile Print app

 

In order to use this feature, Samsung Mobile Print app needs to be 
installed on your cell phone.

 

1 Open Samsung Mobile Print app from your mobile device.

2 Select device setting.

3 Select Google Cloud Print.

4 Enter your printer’s name and description.

 

If the network environment of your printer is using a proxy server, you need 
to configure

the proxy’s IP and port number from Proxy Setting. Contact your network

service provider or network administrator for more information.

 

5 Click Register.

6 You need to authenticate as an administrator. Type in the below default 
ID and Password.

• ID: admin 

• Password: sec00000 

7 Confirm your printer in pop-up window.

Now your printer is registered with Google Cloud Print™ service.

Registering from the Chrome Browser

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

• You should create your Google account in the advance. 
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1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail™ address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

6 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information. 

 

7 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.

 

If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups. 

 

10 Click Finish printer registration.

11 Click Manage your printers.

Now your printer is registered with Google Cloud Print™ service.

Google Cloud Print™-ready devices will appear in the list.
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Registering your Google account to the printer

Registering from Samsung Mobile Print app

 

In order to use this feature, Samsung Mobile Print app needs to be 
installed on your cell phone.

 

1 Open Samsung Mobile Print app from your mobile device.

2 Select device setting.
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3 Select Google Cloud Print.

4 Enter your printer’s name and description.

 

If the network environment is using a proxy server, you need to configure

the proxy’s IP and port number from Proxy Setting. Contact your network

service provider or network administrator for more information.

 

5 Click Register.

Confirm your printer in pop-up window.

6 Click Finish.

Now your printer is registered with Google Cloud Print™ service.

Registering from the Chrome Browser

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

• You should create your Google account in the advance. 

 

1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail™ address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

6 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information. 

 

7 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.
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If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups. 

 

10 Click Finish printer registration.

11 Click Manage your printers.

Now your printer is registered with Google Cloud Print™ service.

Google Cloud Print™-ready devices will appear in the list.
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Printing with Google Cloud Print™

The printing procedure varies depending on the application or the device you 

are using. You can see the application list that supports Google Cloud Print™ 
service.

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet. 

 

Printing from an application on mobile device

The following steps are an example of using the Google Docs™ app from 
Android mobile phone.

1 Install the Cloud Print application on your mobile device. 

 

If you do not have the application, download it from the application store 
such as Android Market or App Store. 

 

2 Access the Google Docs™ application from your mobile device.

3 Tap the option  button of the document that you want to print.

4 Tap the send  button.

5 Tap the Cloud Print  button.

6 Set the printing options if you want.

7 Tap Click here to Print.

Printing from the Chrome browser

The following steps are an example of using the Chrome browser.

1 Run Chrome.

2 Open the document or email that you want to print.

3 Click the wrench icon  in the browser’s top right corner.

4 Click Print. A new tab for printing appears.
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5 Select Print with Google Cloud Print.

6 Click the Print button.



3. Useful Setting Menus
This chapter explains how to browse the current status of your machine, and the method of setting for advanced 
machine setup. 

• Before you begin reading a chapter 209

• Information 210

• Layout 211 

• Paper 213

• Graphic 214

• System Setup 215

• Emulation 219

• Network 221

• Job Manage 224

• Admin setup 201

• Eco 203

• Direct USB 204

• Job Status 205

• Counter 206

• Help 207

• Secure Release 208
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Before you begin reading a chapter

This chapter explains all the features available for this series' models to help users  easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 30).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing  (Menu) 
or from the touch screen.

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the  (Menu) or the touch screen on the control panel, this feature is not applicable (see "Control panel overview" on page 22).

• Some menu names may differ from your machine depending on its options or the models.
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Information

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Information) on the touch screen.

Item Description

Help List
Prints the menu map which shows the layout and 
current settings of this machine.

Configuration Prints a report on the machine's overall configuration.

Network 

Configuration

Prints a report on the machine's current network 
configuration.

Demo Page
Prints the demo page to check whether your machine is 
printing properly or not.

Supplies Information Prints supplies’ information page. 

Usage Counter
Prints a usage page. The usage page contains the total 
number of pages printed.

Account

Prints a report of printout counts for each user. This is 
only available when Job Accounting is enabled from 
the SyncThru™ Web Admin Service. 

PCL Font Prints the PCL font list.

PS Font Prints the PS font list.

EPSON Font Prints the EPSON font list.

KSC5843 Fonta Prints the KSC5843 font list.

KSC5895 Fonta Prints the KSC5895 font list.

KSSM Fonta Prints the KSSM font list.

a. This option may not be available depending on your country.

Item Description
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Layout

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > Layout on the touch screen.

Item Description

Orientation

Selects the direction in which information is printed on a 
page.

• Portrait

• Landscape

Margin

• Common Margin: Sets the margin for each side of 
paper.

• MP Tray: Sets the paper margins in multi-purpose tray.

• Tray X: Sets the paper margins for the paper trays.

• Emulation Mar./Emulation Margin: Sets the paper 
margins for emulation print page.

Duplex

To print on both sides of the paper, choose the binding 
edge.

• Off: Disables this option.

• Long Edge

• Short Edge

Item Description
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Paper

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > Paper on the touch screen.

Item Description

Copies Selects the number of copies.

MP Tray/ [Tray <x>]

• Paper Size: Selects the default paper size.

• Paper Type: Selects the paper type currently loaded 
in the tray.

Paper Source

Sets the default paper tray to use.

 

Auto: Automatically locates the tray with the 
same sized paper as an original. 

 

Tray Confirmation Activates the tray confirmation message. If you open and 
close a tray, a window asking you whether to set the 
paper size and type for the tray just opened appears.
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Graphic

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > Graphic on the touch screen.

Item Description

Resolution

Specifies the number of dots printed per inch (dpi). The 
higher the setting, the sharper printed characters and 
graphics.

Clear Text Prints text darker than on a normal document.

Auto CR
Allows you to append the required carriage return to 
each line feed, which is useful for Unix or DOS users.

Edge Enhance Allows user to enhance sharpness of text and graphics for 
improving readability.
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System Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > System or Tray Behavior on the touch screen.

Item Description

Date & Timea Sets the date and time.

Clock Modea
Selects the format for displaying time between 12 
hours and 24 hours.

Language
Sets the language of the text that appears on the 
control panel display.

Default Paper Size You can set the default paper size to use.

Power Save

Sets how long the machine waits before going to 
power save mode.

When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered.

Wakeup Event

When this option is On, you can wake up the machine 
from the power saving mode with the following 
actions:

• Loading paper in a tray.

• Opening or closing the front cover.

• Pulling a tray out or pushing a tray in.

Job Timeout

When there is no input for a certain period of time, the 
machine cancels the current job. You can set the 
amount of time the machine will wait before canceling 
the job.

Altitude Adjustment
Optimize print quality according to the machine’s 
altitude ("Altitude adjustment" on page 206).

Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• 0 Sec: This option allows you to continue printing 
when the paper size you have set is mismatched 
with the paper in the tray.

• 30 Sec: If a paper mismatch occurs, an error message 
will display. The machine waits for about 30 second, 
then automatically clear the message and continue 
printing. 

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper. 

Item Description
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Auto Tray Switch

Determine whether or not the machine continues 
printing when it detects the paper does not match. For 
example, if both tray 1 and tray 2 are filled with the 
same size paper, the machine automatically prints from 
tray 2 after the tray 1 runs out of paper.

 

This option does not appear if you selected 
Auto for Paper Source from printer driver.

 

Paper Substitution

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you 
set the paper size to Letter in the printer driver, the 
machine prints on A4 paper and vice versa.

Tray Protection

Decides to use or not use the Auto Tray Swi. /Auto 

Tray Switch feature for a certain tray. If you set tray 1 to 
on, for example, then tray 1 is excluded during tray 
switching.

SkipBlankPage

The printer detects the printing data from computer 
whether a page is empty or not. You can set to print or 
skip the blank page.

Item Description

Maintenance

• CLR Empty Msg.:  This option appears only when 
toner cartridge is empty.

• Supplies Life: Allows you to check how many pages 
are printed and how much toner is left in the 
cartridge.

• Image Mgr.: Allows you to adjust the density.

• TonerLow Alert: If toner in the cartridge has run 
out, a message informing the user to change the 
toner cartridge appears. You can set the option for 
this message to appear or not.

• RAM Disk: Enables/disables RAM disk to manage 
jobs.

Toner Save

Activating this mode extends the life of your toner 
cartridge and reduces your cost per page beyond what 
one would experience in the normal mode, but it 
reduces print quality.

Item Description
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Eco Settings

Allows you to save print resources and enables eco-
friendly printing (see "Eco printing" on page 54).

• Default Mode: Select whether to turn the Eco mode 
on or off.

 

On Force: Sets the Eco mode on. If a user wants 
to turn the Eco mode off, the user needs to 
enter the password.

 

• Select Temp.: Selects the eco template set from the 
SyncThru™ Web Service.

Auto Power Off Turns power off automatically when the machine has 
been in power save mode for the length of time set in 
Auto Power Off > On > Timeout.

 

• To turn the machine on again, press the  

(Power) button on the control panel (make 
sure the main power switch is on).

• If you run the printer driver or Samsung Easy 
Printer Manager, the time automatically 
extends.

• While the machine is connected to the 
network or working on a print job, Auto 

Power Off feature doesn't work.

 

Item Description

Held Job Timeout You can set the time to hold the temprarily stopped job.

File Policy

If the memory already has the same name when you 
entered a new file name, you can rename or overwrite 
it.

Job Timeout Sets the length of time the printer waits before printing 
the last page of a print job that does not end with a 
command to print the page.

a. M382xDW only

Item Description
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Emulation

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > Emulation on the touch screen.

Item Description

Emulation Type
The machine language defines how the computer 
communicates with the machine.

Setup Sets the detailed settings for the selected emulation type.
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Network

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Setup) > Network on the touch screen.

 

You can also use this feature from the SyncThru™ Web Service. Open the 
Web browser from your networked computer and type the IP address of 
your machine. When SyncThru™ Web Service opens, click Settings > 
Network Settings (see "Using SyncThru™ Web Service" on page 233).

 

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment (see "Setting 
IP address" on page 139).

 

There are lots of parameters to be set. If you are 
not sure, leave as is, or consult the network 
administrator.

 

TCP/IP (IPv6)
Selects this option to use the network environment 
through IPv6 (see "IPv6 configuration" on page 151).

Ethernet 

Configure the ethernet port and network transmission 
speed.

 

Turn the power off and on after you change this 
option.

 

802.1x

You can select the user authentication for network 
communication. For detailed information consult the 
network administrator.

Wi-Fi
Select this option to use the wireless network (see 
"Wireless network setup" on page 141).

Option Description
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Protocol 

Management

You can activate or deactivate the following protocols.

• HTTP:  You can sets whether to use SyncThru™ Web 
Service or not.

• WINS:  You can configure the WINS server. 
WINS(Windows Internet Name Service) is used in the 
Windows operating system.

• SNMP V1/V2: You have to enable this option to use 
SNMP V1/V2 protocol. Administrator’s can use SNMP 
to monitor and manage machines on the network.

• UPnP(SSDP): You have to enable this option to use 
UPnP(SSDP) protocol.

• MDNS: You have to enable this option to use MDNS 
(Multicast Domain Name System) protocol.

• SetIP: You have to enable this option to use SetIP 
protocol.

• SLP: You can configure SLP (Service Location 
Protocol) settings. This protocol allows host 
applications to find services in a local area network 
without prior configuration.

 

Turn the power off and on after you change this 
option.

 

Network 

Configuration

This list shows information on your machine’s network 
connection and configuration (see "Printing a network 
configuration report" on page 139).

Option Description

Clear Setting

Reverts the network settings to the default values.

 

Turn the power off and on.

 

Option Description
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Job Management

 

• This feature is not supported for M382xD.

• Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" 
on page 30).

 

To change the menu options:

• Select (Setup) > System on the touch screen.

Item Description

Active Job Shows the print job lists that are waiting to be printed.

Secured Job Shows the print job lists that are secured on the disk.

Stored Job Shows the print job lists that are stored on the disk.

File Policy
If the memory already has the same name when you 
entered a new file name, you can rename or overwrite it.
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Admin setup

 

• Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" 
on page 30).

• You need to enter a password to enter this menu. The default password 
is sec00000.

 

To change the menu options:

• Select (Setup) > Admin Setup on the touch screen.

Item Description

User Access 

Control

You can control user access to a machine. You can assign 
different levels of permissions to use the machine to each 
user.

 

 You can also use this feature from the SyncThru™ 
Web Service. Open the Web browser from your 
networked computer and type the IP address of 
your machine. When SyncThru™ Web Service 
opens, click the Security tab > User Access 

Control.

 

Stamp

You can apply the stamp feature.

• Stamp Activate: You can activate stamp feature.

• Item: You can select the items to print on the printout 
such as time, date, and etc.

• Opacity: You can select the stamp transparency.

• Position: Sets the stamp position.

Secure Release

 You can set secure release settings. Secure release feature 
allows you to hold the job on the machine and print after 
authentication. 

• Max Job Count per User: You can set the number of 
print jobs allowed for each user.

• Smart Release: You can print all the stored print jobs 
you sent after loggin in at once.

• Release Mode:  You can choose the release mode. If 
you choose Secure Mode, normal and confidential jobs 
are printed after authentication. However, store jobs 
are printed without an authentication. Other jobs gets 
cancelled. If you choose Mixed Mode, confidential jobs 
are printed after authentication but other jobs are 
printed without an authentication.

Change Admin. 

Password

Changes the machine’s password for accessing the Admin 

Setup.

Firmware Upgrade
To upgrade the latest firmware, turn this option "On" and 
then download the firmware file.

Item Description
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Image Overwrite

You can set the machine to overwrite data stored in the 
memory. The machine overwrites the data with different 
patterns eliminating the possibilities of recovery. 

Application

 You can install or uninstall applications. 

• Application Management: You can uninstall or 
enable/disable installed applications.

• Install New Application: You can install a new 
application from a USB.

Item Description
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Eco

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Eco) on the touch screen.

Item Description

Eco-On/Eco-Off View current eco mode and change on/off option.

Settings

Sets eco-related settings and change default settings.

• Default Mode: Select this to turn on or off the default 
mode. 

• Feature Configuration: Select the Default mode or 
Custom mode. If you select the Custom mode, you can 
set the settings to apply for the Eco mode. 
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Direct USB

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select ( Direct USB) > on the touch screen.

Item Description

Print From Select a file to print.

File Manage Select a file to delete. You can format the USB device.

Show Space Shows the remaining space.
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Job Status

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select ( Job Status) > on the touch screen.

Item Description

Current Job Displays the list of jobs in progress and pending.

Secure Job Displays the list of jobs that are secured on the disk

Stored Job Displays the list of jobs that are stored on the disk.

Complete Job Displays the list of completed jobs.
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Counter

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Counter) > on the touch screen.

Item Description

Total Printed Displays the number of pages printed.
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Help

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Help) > on the touch screen.

Item Description

Basic Taskflow Displays basic method to start your job.

Troubleshooting Displays troubleshooting information.
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Secure Release

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 30).

 

To change the menu options:

• Select (Secure Release) on the touch screen.

 

Displays the list of print jobs the user has set in the printer driver. Set the 
print jobs from the printing preferences window > select the mode from the 
Printer Mode drop-down list (see "Opening printing preferences" on page 
52).

 

Item Description

Options

You can select the authentication methods to use for 
secure release feature. You can select more than one 
method for authentication. For example, if you select Card 
and PIN, users need to be authorized by both card and PIN 
number. 

• Card: You can register the card to use for 
authentication.

• ID/PW:  You can register the ID/PW to use for 
authentication.

• PIN: You can register the PIN number to user for 
authentication.

Stored Job
You can see the jobs stored in the machine and their 
information. You can print or delete the stored jobs.

Current Job
You can see the jobs currently submitted in the machine 
and their information. 
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Before you begin reading a chapter

This chapter explains all the features available for this series' models to help users easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 27).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing  (Menu).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the  (Menu) on the control panel, this feature is not applicable (see "Control panel overview" on page 20).

• Some menu names may differ from your machine depending on its options or the models.
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Information

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Information on the control panel.

Item Description

Menu Map
Prints the menu map which shows the layout and 
current settings of this machine.

Configuration Prints a report on the machine's overall configuration.

Supplies Info. Prints supplies’ information page. 

Demo Page
Prints the demo page to check whether your machine is 
printing properly or not.

PCL Font List Prints the PCL font list.

PS Font List Prints the PS font list.

Usage Counter
Prints a usage page. The usage page contains the total 
number of pages printed.

Account

This is used only available when Job Accounting is 
enabled from the SyncThru™ Web Admin Service. You 
can print a report of printout counts for each user.
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Layout

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Layout on the control panel.

Item Description

Orientation

Selects the direction in which information is printed on a 
page.

• Portrait

• Landscape

Common Margin

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margin for double-sided printing.

• Binding: When printing on both sides of the paper, side 
A's margin closest to the binding will be the same as side 
B's margin closest to the binding. Likewise, the sides' 
margins farthest from the binding will be the same. 

MP Tray

Sets the paper margins in multi-purpose tray.

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margins for double-sided printing.

Manual Feeder Sets the paper margins in manual feeder tray.

<Tray X>

Sets the paper margins for the paper trays.

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margins for double-sided printing.

Emulation Mar.

Sets the paper margins for emulation print page.

• Top Margin: Sets the top margin.

• Left Margin: Sets the left margin.

Item Description
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Duplex

To print on both sides of the paper, choose the binding 
edge.

• Off: Disables this option.

• Long Edge

• Short Edge

Item Description
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Paper

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Paper on the control panel.

Item Description

Copies Selects the number of copies.

MP Tray/ [Tray <x>]

• Paper Size: Selects the default paper size.

• Paper Type: Selects the paper type currently loaded 
in the tray.

Paper Source

Sets the default paper tray to use.

 

Auto: You can set the machine to automatically 
to the tray with the same sized paper when the 
tray in use is empty.
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Graphic

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Graphic on the control panel.

Item Description

Resolution

Specifies the number of dots printed per inch (dpi). The 
higher the setting, the sharper printed characters and 
graphics.

Clear Text Prints text darker than on a normal document.

Edge Enhance
It allows user to enhance sharpness of text and graphics 
for improving readability.

Trapping

It reduces the white gap caused by misalignment of color 
channels in color printing mode. Also black text will be 
overprinted on other colors.

Screen
This option allows you to select options to convert a 
continous-tone image into printable binary image.
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System Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > System Setup on the control panel.

Item Description

Date & Time Sets the date and time.

Clock Mode
Selects the format for displaying time between 12 hr 
and 24 hr.

Language
Sets the language of the text that appears on the 
control panel display.

Power Save

Sets how long the machine waits before going to 
power save mode.

When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered.

Wakeup Event

When this option is On, you can wake up the machine 
from the power saving mode with the following 
actions:

• Pressing any button on the control panel.

• Loading paper in a tray.

• Opening or closing the front cover.

• Pulling a tray out or pushing a tray in.

 

If the machine does not have the touch screen, 
you can wake up the machine from the power 
saving mode by pressing any button on the 
control panel regardless of this option’s setting.

 

Job Timeout

When there is no input for a certain period of time, the 
machine cancels the current job. You can set the 
amount of time the machine will wait before canceling 
the job.

Import Setting
Imports data stored on a USB memory stick to the 
machine ("Backing up data" on page 49).

Export Setting
Exports data stored on the machine stick to a USB 
memory ("Restoring data" on page 50).

Altitude Adj.
Optimize print quality according to the machine’s 
altitude ("Altitude adjustment" on page 206).

Item Description
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Humidity Optimizes print quality according to the humidity in the 
environment.

Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper.

• On: If a paper mismatch occurs, an error message 
will display. The machine waits for about 30 second, 
then automatically clear the message and continue 
printing.

Auto CR
Allows you to append the required carriage return to 
each line feed, which is useful for Unix or DOS users.

Auto Tray Swi.

Determine whether or not the machine continues 
printing when it detects the paper does not match. For 
example, if both tray 1 and tray 2 are filled with the 
same size paper, the machine automatically prints from 
tray 2 after the tray 1 runs out of paper.

 

This option does not appear if you selected 
Auto for Paper Source from printer driver.

 

Item Description

Paper Substit.

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you 
set the paper size to Letter in the printer driver, the 
machine prints on A4 paper and vice versa.

Tray Protect

Decides to use or not use the Auto Tray Swi. feature. If 
you set tray 1 to on, for example, then tray 1 is excluded 
during tray switching.

Print BlankPage

The printer detects the printing data from computer 
whether a page is empty or not. You can set to print or 
skip the blank page.

Item Description
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Maintenance

• CLR Empty Msg.:  This option appears only when 
toner cartridge is empty.

• Supplies Life: Allows you to check how many pages 
are printed and how much toner is left in the 
cartridge.

• TonerLow Alert: If toner in the cartridge has run 
out, a message informing the user to change the 
toner cartridge appears. You can set the option for 
this message to appear or not.

• Paper Stacking: If you use a machine in a humid 
area, or you are using the damp print media caused 
by a high humidity, the print-outs on the output tray 
may be curled and may not be stacked properly. In 
this case, you can set the machine to use this 
function to let print-outs stacked firmly. But, using 
this function will make the print speed slow.

• Ram Disk: Enables/disables RAM disk to manage 
jobs.

Item Description

Eco Setup

Allows you to save print resources and enables eco-
friendly printing (see "Eco printing" on page 45).

• Default Mode: Select whether to turn the Eco mode 
on or off.

 

On Force: Sets the Eco mode on. If a user wants 
to turn the Eco mode off, the user needs to 
enter the password.

 

• Change Temp.: Selects the eco template set from 
the SyncThru™ Web Service.

Vapor Mode You can reduce the amount of water vapor produced 
during printing.

• On: Enables vapor mode.

• Off: Disables vapor mode.

• Auto: Automatically enters vapor mode according 
to time in high humidity environments.

 

Enabling the Vapor Mode option can make the 
printing speed slower.

 

Item Description
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Auto Power Off Turns power off automatically when the machine has 
been in power save mode for the length of time set in 
Auto Power Off > On > Timeout.

 

• To turn the machine on again, press the  

(Power) button on the control panel (make 
sure the main power switch is on).

• If you run the printer driver or Samsung Easy 
Printer Manager, the time automatically 
extends.

• While the machine is connected to the 
network or working on a print job, Auto 

Power Off feature doesn't work.

 

Item Description
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Emulation

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Emulation on the control panel.

Item Description

Emulation Type
The machine language defines how the computer 
communicates with the machine.

Setup Sets the detailed settings for the selected emulation type.
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Image Mgr.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Image Mgr. on the control panel.

Option Description

Custom Color This menu allows you to adjust contrast, color by 
color.

• Default: Optimizes colors automatically. 

• Print Density: Allows you to manually adjust 
color density for print. Adjust the print density.

It is recommended to use the Default setting for best 
color quality.

Auto Color Reg. The machine virtually prints certain patterned image 
to calibrate the color printing position. This feature 
enhances the colored image sharper and clearer, 
which means the machine prints the colored image 
on the paper more like the one in the monitor.

 

If you have moved the machine, it is strongly 
recommended to operate this menu 
manually.

 

Tone Adjust. • Default: The machine automatically calibrate the 
toner density of machine for the best possible 
color print quality. 
If you select Off, the machine is calibrated by the 
factory default toner density.

• Auto Tone Adj.: Allows you to automatically 
adjust tone for the best possible print quality.

• Cal. ID Sensor: Automatically calculates the 
reduced or worn out supplies like toner or 
machine parts and uses this information to adjust 
the color density. For example, if the yellow toner 
is running out, the machine calculates the amount 
of remaining yellow toner and adjusts color 
density so the printouts are fine.

Option Description
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Network

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Network on the control panel.

 

You can also use this feature from the SyncThru™ Web Service. Open the 
Web browser from your networked computer and type the IP address of 
your machine. When SyncThru™ Web Service opens, click Settings > 
Network Settings (see "Using SyncThru™ Web Service" on page 233).

 

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment (see "Setting 
IP address" on page 126).

 

There are lots of parameters to be set. If you are 
not sure, leave as is, or consult the network 
administrator.

 

TCP/IP (IPv6)
Selects this option to use the network environment 
through IPv6 (see "IPv6 configuration" on page 138).

Ethernet Speed

Configure the network transmission speed.

 

Turn the power off and on after you change this 
option.

 

802.1x

You can selects the user authentication for network 
communication. For detailed information consult the 
network administrator.

Wireless
Selects this option to use the wireless network (see 
"Wireless network setup" on page 141).

Clear Setting

Reverts the network settings to the default values.

 

Turn the power off and on.

 

Network Conf.

This list shows information on your machine’s network 
connection and configuration (see "Printing a network 
configuration report" on page 126).

Net. Activate

You can set whether to use Ethernet on or off.

 

Turn the power off and on after you change this 
option.

 

Option Description
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Http Activate

You can set whether to use SyncThru™ Web Service or 
not.

 

Turn the power off and on after you change this 
option.

 

WINS

You can configure the WINS server. WINS(Windows 
Internet Name Service) is used in the Windows operating 
system. 

 

Turn the power off and on after you change this 
option.

 

SNMP V1/V2

You can set SNMP (Simple Network Management 
Protocol). Administrator’s can use SNMP to monitor and 
manage machines on the network.

SNTP

You can set SNTP (Simple Network Time Protocol) 
settings. SNTP synchronizes the clocks of the computer 
systems through the Internet (NTP) so there would not be 
a time difference when exchanging data.

Option Description

UPnP(SSDP)

You can set UPnP (SSDP) protocol.

 

Turn the power off and on after you change this 
option.

 

MDNS
You can set mDNS (Multicast Domain Name System) 
settings.

SetIP You can set SetIP settings.

SLP

You can configure SLP (Service Location Protocol) 
settings. This protocol allows host applications to find 
services in a local area network without prior 
configuration.

 

Turn the power off and on after you change this 
option.

 

Option Description
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Direct USB

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

If you want to use this feature, you need to insert a USB memory device into the 
USB memory port on your machine. 

To change the menu options:

• Press  (Menu) > Direct USB on the control panel (see "Using USB memory 
device" on page 48).

Item Description

USB Print
You can directly print files stored on a USB memory 
device.

File Manage

You can delete image files stored on a USB memory 
device one by one or all at once by reformatting the 
device.

Check Space
You can check the amount of memory space available 
for saving documents.
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Job Manage

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 27).

 

To change the menu options:

• Press  (Menu) > Job Manage on the control panel.

Item Description

Active Job Shows the print job lists that are waiting to be printed.

Secured Job Shows the print job lists that are secured on the disk.

Stored Job Shows the print job lists that are stored on the disk.

File Policy
If the memory already has the same name when you 
entered a new file name, you can rename or overwrite it.



4. Special Features
This chapter explains special printing features.

• Altitude adjustment 206

• Entering various characters 207

• Printing features 208

• Using Direct Printing Utility 224

• Mac printing 226

• Linux printing 228

• Unix printing 230

• Using optional device features 232

 

• The procedures in this chapter are mainly based on Windows 7.

• It may be necessary to press OK to navigate to lower-level menus for some models.
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Altitude adjustment

Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

1 High 3

2 High 2

3 High 1

4 Normal

You can set the altitude value from Device Settings in Samsung Easy Printer 
Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer Manager 

> (Switch to advanced mode) > Device Settings, see "Device 
Settings" on page 239.

 

• If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 
233).

• You can also set the altitude in System Setup option on the machine’s 
display (see "Machine’s basic settings" on page 30).
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Entering various characters

 

CLP-68xSeries only.

 

As you perform various tasks, you may need to enter names and numbers.

1 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For example, to 
enter the letter O, press 6, labeled with MNO. Each time you press 6, the display 
shows a different letter, M, N, O, m, n, o and finally 6. To find the letter that you 
want to enter, see "Keypad letters and numbers" on page 207.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the arrow button.

 

2 

Keypad letters and numbers

 

• Special character sets may differ from your machine depending on its 
options or the models.

• Some of the follow key values may not appear depending on the job you 
are doing.

 

Key Assigned numbers, letters, or characters

1 @ / . ’ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* * % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for network authentication.)

# # = | ? " : { } < > ;

(These symbols are available when you type for network authentication.)
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Printing features

 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 42).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

3 

Changing the default print settings

1 Click the Windows Start menu. 

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

3 Right-click on your machine.

4 For Windows XP/Server 2003/Server 2008/Vista, select Printing 

Preferences.

For Windows 7/8 or Windows Server 2008 R2, from context menus, select 
Printing preferences.

 

If Printing preferences has a �, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 

Preferences. 

 

4 

Setting your machine as a default machine

1 Click the Windows Start menu.

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 
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3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

For Windows 7 or Windows Server 2008 R2, if Set as default printer has a 
�, you can select other printer drivers connected to the selected printer.

 

5 

Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by models" on page 7.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• Install optional memory when an XPS job does not print because the 
printer is out of memory.

• For models that provide XPS driver from the Samsung website, http://
www.samsung.com  > find your product> Support or downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 

Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, which appears in the printer properties window, may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 44).

 

 

Item Description

Multiple Pages per 

Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 
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Poster Printing

Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.

Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

Item Description

8 9
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• Double-sided 

Printing

• Double-sided 

Printing (Manual)a

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page of 
the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

• We recommend not to print on both sides of the special media, such as labels, envelopes, or thick paper. It may cause a paper jam or 
damage the machine.

 

Item Description
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• Double-sided 

Printing

• Double-sided 

Printing (Manual)a

 

Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the machine. 

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing. This option is not available when you 
use Double-sided Printing (Manual).

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Item Description
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Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Watermark

(Creating a 

watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a 

watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Item Description
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Overlaya

This option is available only when you use the PCL/SPL printer driver (see "Software" on page 7).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Overlaya

(Creating a new page 

overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
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Overlaya

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file you 

want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 

List box. 
d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 

document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlaya

(Deleting a page 

overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

(CLP-68x Series only)

 

•  This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on page 8).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• To enable this feature, check Storage Options (see "Setting Device Options" on page 67).

• Without installing the mass storage device (HDD) in the machine, the Ram Disk feature provides only 3 options: Normal, Proof, and 
Confidential.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory. 

- Normal: This mode prints without storing your document in the optional memory. 

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies later. 

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 

- Store: Select this setting to save a document in the mass storage device (HDD) without printing. 

- Store and Print: This mode is used when printing and storing document at the same time. 

- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer spools the document into the 
mass storage device (HDD) and then prints it from the mass storage device (HDD) queue, decreasing the computer’s work load.

- Print Schedule: Select this setting to print the document at a specified time.

 

• Job Name: This option is used when you need to find a stored file using the control panel.

• User ID: This option is used when you need to find a stored file using the control panel. The user name automatically appears as the 
user name that you use to log on Windows.

• Enter Password: If the Property of the document you selected is secured, you have to enter the password for the document. This 
option is used for loading a stored file using the control panel. 

• Confirm Password: Re-enter the password to confirm it.

 

Item Description
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Job Accounting

This option allows you to print with the given permission.

• User permission: If you check this option, only users with user permission can start a print job.

• Group permission: If you check this option, only groups with group permission can start a print job.

 

• Click the question mark( ) from the upper-right corner of the window and click on any option you want to know about.

• Administrators can enable job accounting and configure permissions in the control panel or SyncThru™ Web Admin Service.

 

a. This option is not available when you use XPS driver.

Item Description
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Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 8).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 

7 

Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.
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Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open the document to print.

2 Open the File menu and click Page Setup (Print Setup for some

applications).

3  Choose your paper size, orientation, and make

sure that your machine is selected. Click Apply.

4  Open the File menu and click Print.

5  Select your machine to print.

6 Choose the number of copies and indicate which pages to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing (see "Features by models" on page 7).

 

Printing files

You can print text, image, pdf files on your machine using the standard

CUPS directly from the command line interface. The CUPS lp or lpr utility allows 
you to do that. You can print these files by using below command format.

"lp -d <printer name> -o <option> <file name>"

Please refer to lp or lpr man page on your system for more details.

Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, 
you can change the various properties for your machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click Properties.
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3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and name. The 
name entered in this tab displays on the printer list in Printers 

configuration.

• Connection: Allows you to view or select another port. If you change 
the machine port from USB to parallel or vice versa while in use, you 
must re-configure the machine port in this tab.

• Driver: Allows you to view or select another machine driver. By 
clicking Options, you can set the default device options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel the 
selected job and select the Show completed jobs check box to see 
previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add to Class 
to add your machine to a specific class or click Remove from Class 
to remove the machine from the selected class.

4 Click OK to apply the changes and close the Printer Properties window.

8 

Unix printing 

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Features by models" on 
page 7).

 

Proceeding the print job

After installing the printer, choose any of the image, text, or PS files to print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2 Select a printer that has been already added.

3 Select the printing options from the window such as Page Selection.

4 Select how many copies are needed in Number of Copies.
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To take advantage of the printer features provided by your printer driver, 
press Properties.

 

5 Press OK to start the print job.

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can select various 
print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” for Apply, 
and “C” for Cancel.

General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according 
to your requirements.

• Paper Type: Choose the type of the paper. Options available in the list box 
are Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By default, it is Auto 

Selection.
• Orientation: Select the direction in which information is printed on a page.
• Duplex: Print on both sides of paper to save paper.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Multiple pages: Print several pages on one side of the paper.

• Page Border: Choose any of the border styles (e.g., Single-line hairline, 
Double-line hairline)

Image tab

In this tab, you can change the brightness, resolution, or image position of your 
document.

Text tab

Set the character margin, line space, or the columns of the actual print output.

Margins tab

• Use Margins: Set the margins for the document. By default, margins are not 
enabled. The user can change the margin settings by changing the values in 
the respective fields. Set by default, these values depend on the page size 
selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab

Select various options in the JCL and General frames to customize various 
settings. These options are specific to the printer and depend on the PPD file.
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Using Direct Printing Utility

 

•  Direct Printing Utility may not be available depending on model or 
optional goods (see "Software" on page 7). 

• Available for Windows OS users only.

 

9 

What is Direct Printing Utility?

Direct Printing Utility is a program that sends the PDF files directly to your 
machine to print without having to opening the file.

To install this program:

Download the software from the Samsung website then unpack and install it: 
(http://www.samsung.com > find your product > Support or Downloads).

 

• Optional memory or mass storage device (HDD) should be installed on 
your machine, to print files using this program (see "Variety feature" on 
page 8).

• You cannot print PDF files that are restricted. Deactivate the printing 
restriction feature and retry printing.

• You cannot print PDF files that are restricted by a password. Deactivate 
the password feature, and retry printing.

• Whether or not a PDF file can be printed using the Direct Printing Utility 
program depends on how the PDF file was created.

• The Direct Printing Utility program supports PDF version 1.7 and below. 
For higher versions, you must open the file to print it.

 

10 

Printing

There are several ways you can print using the Direct Printing Utility.

1 From the Start menu select Programs or All Programs > Samsung 

Printers > Direct Printing Utility > Direct Printing Utility.

The Direct Printing Utility window appears.

2 Select your machine from the Select Printer drop-down list and click 
Browse.

3 Select the file you wish to print and click Open.

The file is added in the Select Files section.

4 Customize the machine settings for your needs. 

5 Click Print. The selected PDF file is sent to the machine.

11 

Using the right-click menu

1 Right-click on the PDF file to print and select Direct Printing.

The Direct Printing Utility window appears with the PDF file is added.

2 Select the machine to use.
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3 Customize the machine settings. 

4 Click Print. The selected PDF file is sent to the machine.
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Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

12 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

13 

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

14 

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 7).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

16 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 
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Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

17 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open the document to print.

2 Open the File menu and click Page Setup (Print Setup in some 
applications).

3 Choose your paper size, orientation, and make sure that your machine is 
selected. Click Apply.

4 Open the File menu and click Print.

5 Select your machine to print.

6 Choose the number of copies and indicate which pages to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lp or lpr printing system or other 
applications for odd-even printing.

 

18 

Printing files

You can print text, image, pdf files on your machine using the standard CUPS, 
directly from the command line interface. The CUPS lp or lpr utility allows you to 
do that. You can print these files by using below command format.

"lp -d <printer name> -o <option> <file name>"

Please refer to lp or lpr man page on your system for more details.



Linux printing

2294.  Special Features

19 

Configuring Printer Properties

You can change the default printing options or connection type with Printing 
utility supplied by o/s.

1 Launch Printing utility(Go to System > Administration > Printing 
menu or execute "system-config-printer" command in Terminal 
program).

2 Select your printer and double-click it.

3 Change default printing options or connection type.

4 Click Apply button.
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Unix printing 

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Features by models" on 
page 6).

 

20 

Proceeding the print job

After installing the printer, choose any of the image, text, or PS files to print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2 Select a printer that has been already added.

3 Select the printing options from the window such as Page Selection.

4 Select how many copies are needed in Number of Copies.

 

To take advantage of the printer features provided by your printer driver, 
press Properties.

 

5 Press OK to start the print job.

21 

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can select various 
print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” for Apply, 
and “C” for Cancel.

General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according 
to your requirements.

• Paper Type: Choose the type of the paper. Options available in the list box 
are Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By default, it is Auto 

Selection.

• Orientation: Select the direction in which information is printed on a page.

• Duplex: Print on both sides of paper to save paper.
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Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Multiple pages: Print several pages on one side of the paper.

• Page Border: Choose any of the border styles (e.g., Single-line hairline, 
Double-line hairline)

Image tab

In this tab, you can change the brightness, resolution, or image position of your 
document.

Text tab

Set the character margin, line space, or the columns of the actual print output.

Margins tab

• Use Margins: Set the margins for the document. By default, margins are not 
enabled. The user can change the margin settings by changing the values in 
the respective fields. Set by default, these values depend on the page size 
selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab

Select various options in the JCL and General frames to customize various 
settings. These options are specific to the printer and depend on the PPD file.
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Using optional device features

 

• CLP-68x Series only.

• Some features may not be available depending on model or optional 
goods (see "Variety feature" on page 8).

 

22 

From the printer driver

If you install the optional device, you can use advanced printing features, such 
as proofing a job and printing a private job in the Print window. Check the mass 
storage (HDD) or RAM disk option in Device Options, then you can select the 
various features from Print Mode (see "Setting Device Options" on page 67).

1 Open the document you want to print.

2 Select Print from the File menu. The Print window appears. 

3 Select your printer driver from the Select Printer list.

4 Click Properties or Preferences.

5 Click the each tab then select Print Mode.

6 Select the option you want (see "Understanding special printer features" 
on page 210).

23 

From the control panel

If your machine has optional mass storage device (HDD) or ram disk, you can use 

these features from the  (Menu) button> System Setup > Job Manage. 

 

Some menus may not appear on the display depending on options or 
models. If so, it is not applicable to your machine.

 

• Active Job: All of the print jobs waiting to be printed are listed in the active 
job queue in the order you sent them to the printer. You can delete a job 
from the queue before printing, or promote a job to print sooner.

• Secured Job: You can print or delete a secured job. Shows the list of secured 
jobs the user has set in the printer driver. You need to enter the user name 
and password set in the printer driver.

• Stored Job: You can print or delete a stored job.

• File Policy: You can choose the file policy for generating file name before 
you proceed with the job through optional memory. If the optional memory 
already has the same name when you entered a new file name, you can 
rename or overwrite it.
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Accessing management tools

Samsung provides a variety of management tools for Samsung printers. 

1 Make sure that the machine is connected to your computer and 
powered on.

2 From the Start menu, select Programs or All Programs.

• For Windows 8, from Charms, select Search > Apps.

3 Find Samsung Printers.

4 Under Samsung Printers, you can see installed management tools.

5 Click the management tool you want to use.

 

• After installing the driver, for some management tools, you can access 
them directly from the Start screen by clicking on the corresponding tile.

• For Windows 8, after installing the driver, for some management tools, 
you can access them directly from the Start screen by clicking on the 
corresponding tile.
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Easy Capture Manager

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows OS users only (see "Software" on page 7).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key on the keyboard. Now you can easily print your captured screen as 
captured or edited.
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Samsung AnyWeb Print

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

This tool helps you screen-capture, preview, scrap, and print Windows Internet Explorer pages more easily, than when you use an ordinary program. 

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Samsung Easy Color Manager

Samsung Easy Color Manager helps users do fine adjustments with 6 color tones and other properties, such as brightness, contrast, and saturation. Color tone 
changes can be saved as a profile and can be used from the driver or from inside of the machine.

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

Helps Samsung color laser printer users to adjust color as they like.

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Easy Eco Driver

 

Available for Windows OS users only (see "Software" on page 7).

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. 

Easy Eco Driver also allows you simple editing such as removing images and texts, and more. You can save frequently used settings as a preset.

How to use: 

1 Open a document to print.

2 Open printing preference window (see "Opening printing preferences" on page 43).

3 From the Favorites tab, select Eco Printing Preview.

4 Click OK > Print in the window. A preview window appears.

5 Select the options you want to apply to the document.

You can see the preview of the applied features.

6 Click Print.

 

If you want to run Easy Eco Driver every time you print, check Start Easy Eco Driver before printing job checkbox in the Basic tab of the printing preference 
window.
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Using SyncThru™ Web Service

 

• Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only (see "Software" on page 7).
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Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to log-in as an 
administrator. You can still use SyncThru™ Web Service without logging in but 
you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service website.

2 Type in the ID and Password then click Login. Type in the below default 
ID and password. We recommend you to change the default password 
for security reasons.

• ID: admin 

• Password: sec00000 

2 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.
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Information tab

This tab gives you general information about your machine. You can check 
things, such as remaining amount of toner. You can also print reports, such as an 
error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.

• Usage Counters: Shows the usage count by print types: simplex and 
duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports, e-mail 
address, and font reports.

Settings tab

This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 
log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: Sets settings for HTTPs, IPSec, IPv4/IPv6 filtering, 802.1x, 
and Authentication servers.

• User Access Control: Classifies users into several groups according to each 
user’s role. Each user’s authorization, authentication and accounting will be 
controlled by the group’s role definition.

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.

• License Management: License management provides settings installed 
applications and application license.
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• Cloning: You can import or export (transfer) various settings (machine 
setting, network information, address book, etc.) between devices that have 
the Cloning feature in SyncThru™ Web Service.
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E-mail notification setup

You can receive emails about your machine’s status by setting this option. By 
setting information such as IP address, host name, e-mail address and SMTP 
server information, the machine status (toner cartridge shortage or machine 
error) will be sent to a certain person's e-mail automatically. This option may be 
used more frequently by a machine administrator. 

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Settings tab, select Machine Settings > E-mail Notification. 

 

If you have not configured outgoing server environment, go to Settings > 
Network Settings > Outgoing Mail Server(SMTP) to configure network 
environment before setting e-mail notification. 

 

4 Select Enable check box to use the E-mail Notification.

5 Click Add button to add e-mail notification user. 

Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

6 Click Apply.

 

If the firewall is activated, the e-mail may not be sent successfully. In that 
case, contact the a network administrator.

 

4 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.
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1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Security tab, select System Security > System Administrator

4 Enter the name of the administrator, phone number, location, and email 
address. 

5 Click Apply. 



2375.  Useful Management Tools

Using Samsung Easy Printer Manager 

 

• This feature may not be available depending on model or optional goods 
(see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager combines 
device settings as well as printing environments, settings/actions and 
launching. All of these features provide a gateway to conveniently use your 
Samsung machine. Samsung Easy Printer Manager provides two different user 
interfaces for the user to choose from: the basic user interface and the advanced 
user interface. Switching between the two interfaces is easy: just click a button.

5 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 

Easy Printer Manager.

For Mac,

Open the Applications folder > Samsung folder > Samsung Easy Printer 

Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer List displays printers installed on your computer 

and network printers added by network discovery (Windows 
only).



Using Samsung Easy Printer Manager
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Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

6 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person responsible 
for managing the network and machines.

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the machine’s 
model name, IP address (or Port name), and machine status.

 

You can view the online User’s Guide.

 Troubleshooting button: This button opens the 
Troubleshooting Guide when an error occurs. You 
can directly open the necessary section in the user’s 
guide. 

 

3

Application 
information

Includes links for changing to the advanced settings 
(switching UI), refresh, preference setting, summary, help, 
and about.

 

The  button is used to change the user interface 
to the advanced settings user interface (see 
"Advanced settings user interface overview" on 
page 238).

 

4

Quick links Displays Quick links to machine specific functions. This 
section also includes links to applications in the advanced 
settings.

 

If you connect your machine to a network, the 
SyncThru™ Web Service icon is enabled.

 

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information will vary 
based on the machine selected. Some machines do not have 
this feature.

6
Order supplies Click on the Order button from the supply ordering window. 

You can order replacement toner cartridge(s) from online.
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Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

Device Settings

You can configure various machine settings such as machine setup, paper, 
layout, emulation, network, and print information.

Alert Settings (Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be received.

• Email Alert: Provides options relating to receiving alerts via email.

• Alert History:  Provides a history of device and toner related alerts.

Job Accounting

Provides querying of quota information of the specified job accounting user. 
This quota information can be created and applied to devices by job accounting 
software such as SyncThru™ or CounThru™ admin software.



2405.  Useful Management Tools

Using Samsung Printer Status 

The Samsung Printer Status is a program that monitors and informs you of the 
machine status. 

 

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 96).

• Available for Windows OS users only (see "Software" on page 7).

 

7 

Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 
Printer Status. Samsung Printer Status is installed automatically when you install 
the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 

Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might occur 
in the future. For example, it might be in toner low 
status, which may lead to toner empty status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.
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2 Option You can set printing job alert related settings. 

3
Order Supplies You can order replacement toner cartridge(s) from 

online.

4

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting 

Guide when an error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

 

5 Close Close the window.



2425.  Useful Management Tools

Using Samsung Printer Experience 

Samsung Printer Experience is a Samsung application that combines 
Samsung machine settings and machine management into one location. You 
can set device settings, order supplies, open troubleshooting guides, visit 
Samsung’s website, and check connected machine information. This application 
will be automatically downloaded from the Windows Store if the machine is 
connected to a computer with an Internet connection. 

8 

Understanding the Samsung Printer Experience

To open the application, 

From the Start screen, select the Samsung Printer Experience ( ) tile. 

The Samsung Printer Experience interface comprises various useful features as 
described in the following table:

 

The screenshot may differ depending on the model you are using.

 

1

Printer 

Information

This area gives you general information about your 
machine. You can check information, such as the 
machine’s status, location, IP address, and remaining 
toner level.
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9 

Adding/Deleting Printers

If you do not have any printer added to the Samsung Printer Experience, or if 
you want to add/delete a printer, follow the instructions below. 

 

You can only add/delete network connected printers.

 

Adding a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Add Printer

3 Select the printer you want to add.

You can see the added printer.

 

If you see  mark, you can also click  mark to add printers.

 

2 User Guide You can view the online User’s Guide. You need to be 
connected to the Internet to use this feature.

 

This button opens the Troubleshooting Guide 
when an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

3
Order 

Supplies

Click on this button to order replacement toner 
cartridges online. You need to be connected to the 
Internet to use this feature. 

4
Visit Samsung Links to Samsung printer website. You need to be 

connected to the Internet to use this feature.

5

Printer Settings You can configure various machine settings such as 
machine setup, paper, layout, emulation, networking, 
and print information through SyncThru™ Web Service. 
Your machine needs to be connected to a network. This 
button will be disabled if your machine is connected via 
USB cable.

6

Device List & 
Latest Scanned 

Image

The scan list displays devices that supports Samsung 

Printer Experience. Under the device, you can see the 
latest scanned images. Your machine needs to be 
connected to a network to scan from here. 

This section is for the users with multi-functional printers.
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Deleting a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Remove Printer.

3 Select the printer you want to delete.

4 Click Yes.

You can see that the selected printer is removed from the screen.

10 

Printing from Windows 8

This section explains common printing tasks from the Start screen.

Basic printing

1 Open the document to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Select the printer settings, such as the number of copies and orientation.

5 Click the Print button to start the print job.
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Cancelling a print job

If the printing job is waiting in the print queue or print spooler, cancel the job as 
follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel or Stop/Clear) 
button on the control panel.

Opening more settings

 

The screen may appear somewhat different depending on the model or 
options.

 

You can set up more printing parameters.

1 Open the document you want to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Click More settings.

Basic tab

Basic

This option allows you to choose the basic printing settings such as copies, 
orientation, and document type.

Eco settings

This option allows you to choose multiple pages per side to save media.
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Advanced tab

Paper settings

This option allows you to set the basic paper handling specifications.

Layout settings

This option allows you to set the various ways to layout your documents.

Security tab

 

Some features may not be available depending on the model or options. If 
this tab is not shown or disabled, it means that this features are not 
supported.

 

Job Accounting

This option allows you to print with the given permission.

Confidential Printing

This option is used for printing confidential documents. You need to enter a 
password to print using it.
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Using the sharing feature

 Samsung Printer Experience allows you to print from other applications 
installed on the computer using the sharing feature. 

 

 This feature is only available for printing jpeg, bmp, tiff, gif, and png file 
formats.

 

1 Select the content you want to print from other application.

2 From the Charms, select Share > Samsung Printer Experience.

3 Select the printer settings, such as the number of copies and orientation.

4 Click the Print button to start the print job.

11 

Scanning from Windows 8

 

This section is for the users with multi-functional printers.

 

Scanning with your machine lets you turn pictures and text into digital files that 
can be stored on your computer.

Scanning from Samsung Printer Experience

The most frequently used printing menus are displayed for quick scanning.

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder.

2 Click the Samsung Printer Experience tile on the Start screen.

3 Click Scan ( ).

4 Set up the scanning parameters such as image type, document size, and 
resolution.

5 Click Prescan ( ) to check the image.

6 Adjust the prescanned image with scanning operation functions such as 
rotate and mirror.

7 Click Scan ( )and save the image. 

 

• When you place the originals in the ADF (or DADF), Prescan ( ) is not 

available.

• You can skip step 5, if the Prescan option is selected.

 



6. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Paper feeding problems 253

• Power and cable connecting problems 254

• Printing problems 255

• Printing quality problems 259

• Operating system problems 267

 

 For errors that occur during the wireless software installation and settings, refer to the 
troubleshooting section in the wireless setting chapter (see "Troubleshooting for wireless 
network" on page 163).

 



2536.  Troubleshooting

Paper feeding problems

Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, use the 
manual feeding in tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Envelopes skew or fail to feed correctly. Ensure that the paper guides are against both sides of the envelopes.



2546.  Troubleshooting

Power and cable connecting problems

 Click this link to open an animation about solving power problems.

 

 

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 

computer and the machine is not 

connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power) button on the control, press it. 

• Disconnect the machine’s cable and reconnect it.
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Printing problems

Condition Possible cause Suggested solutions

The machine does not 

print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  (Power) 

button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The cover is not closed. Close the cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 80).

• No paper is loaded. Load paper (see "Loading paper in the tray" on page 32).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 62).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 62).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 19).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.
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The machine does not 

print.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 

materials from the wrong 

paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening printing preferences" on page 43). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 44).

A print job is extremely 

slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening printing preferences" on 
page 43). See the printer driver help screen (see "Using help" on page 44).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening printing preferences" on 
page 43).

The machine prints, but 

the text is wrong, 

garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

Condition Possible cause Suggested solutions
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The wrong printer driver was selected. Check the application's printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 

blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 60.

• See "Replacing the toner cartridge" on page 62.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 

print PDF files correctly. 

Some parts of graphics, 

text, or illustrations are 

missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 

photos is not good. 

Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Before printing, the 

machine emits vapor near 

the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

Condition Possible cause Suggested solutions
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The machine does not 

print custom-sized paper, 

such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening printing preferences" on page 43).

The printed billing paper 

is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thin (see "Opening printing preferences" on page 43).

Condition Possible cause Suggested solutions
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 62).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 73).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
73). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 

printed lighter than the rest of 

the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 43).
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Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 73).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 73).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick (see "Opening 
printing preferences" on page 43).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 73).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 73).

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and 
install a new one (see "Replacing the toner cartridge" on page 62).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
73). If these steps do not correct the problem, contact a service representative.

Black or color background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 62).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 60).

Toner smear • Clean the inside of the machine (see "Cleaning the machine" on page 73).

• Check the paper type and quality.

• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 62).

Condition Suggested solutions
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Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see 
"Replacing the toner cartridge" on page 62).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams 
on the reverse side. Printing on seams can cause problems.
Or select Thick from the Printing Preferences window (see "Opening printing preferences" on page 43).

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening printing preferences" on page 43). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 60).

Toner particles are around bold 

characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 43).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Condition Suggested solutions

A
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Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested solutions

A a B b CA a B b CA a B b CA a B b CA a B b C c
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Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 73).

Solid color or black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 62).

• The machine may require repairing. Contact a service representative.

Condition Suggested solutions

A
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Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 73).

• Check the paper type, thickness, and quality.

• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 62).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 62).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested solutions

A
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Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening printing preferences" on page 43).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (see 
"Altitude adjustment" on page 206).

Condition Suggested solutions
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Operating system problems

1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 

during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 

“Exception OE”, “Spool 32”, or 

“Illegal Operation” messages 

appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 

timeout error occurred” 

message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.

Samsung Printer Experience is 

not shown when you click more 

settings.

Samsung Printer Experience is not installed. Download the app from the Windows Store and install it.

Machine information is not 

displayed when you click the 

device in the Devices and 

Printers.

Check the Printer properties. Click the Ports tab.

(Control Panel > Devices and Printers > Right-click on your printer icon and select Printer properties)

If the port is set to File or LPT, uncheck them and select TCP/IP, USB, or WSD.
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2 

Common Mac problems

 

 

 

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

 

Condition Suggested solutions

The machine does not print PDF files 

correctly. Some parts of graphics, text, or 

illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 

during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Mac with 

Acrobat Reader 6.0 or higher, colors 

print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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Common Linux problems

 

 

 

Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

Condition Suggested solutions

When printing more than one 

copy, the second copy does not 

print. 

The problem occurs on Ubuntu 12.04 due to the problem in standard CUPS filter 'pdftops'. Update 'cups-filters' package to version 
1.0.18 to fix the problem ('pdftops' is a part of 'cups-filters' package).

Unchecking the collate option 

in the Print Dialog does not 

work.

For some distributions, GNOME Print Dialog has an issue handling the collate option. As workaround, set the default value of collate 
option to False using the system's printing utility(execute "system-config-printer" in the Terminal program).

Printing always works with 

duplex.

This duplex issue was in Ubuntu 9.10 CUPS package. Update CUPS version to 1.4.1-5ubuntu2.2.

Printer is not added through 

system's printing utility.

The problem occurs on Debian 7 due to the defect in 'system-config-printer' package of the Debian 7 (http://bugs.debian.org/cgi-
bin/bugreport.cgi?bug=662813 in Debian bug tracking system). Please use another way to add printer (CUPS WebUI for example)

Paper size and orientation are 

disabled in the Print Dialog 

when opening text files.

The problem occurs on Fedora 19 and it's related to 'leafpad' text editor on Fedora 19. Please use other text editors like 'gedit'.
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Common PostScript problems

The following situations are PS language specific and may occur when several printer languages are used.

 

 

Problem Possible cause Solution

The PostScript file cannot be 

printed

The PostScript driver may not be installed 
correctly.

• Install the PostScript driver (see "Software Installation" on page 119).

• Print a configuration page and verify that the PS version is available for 
printing.

• If the problem persists, contact a service representative.

Limit Check Error report prints The print job was too complex. You might need to reduce the complexity of the page or install more memory.

A PostScript error page prints The print job may not be PostScript. Make sure that the print job is a PostScript job. Check to see whether the software 
application expected a setup or PostScript header file to be sent to the machine.

The optional tray is not 

selected in the driver

The printer driver has not been configured to 
recognize the optional tray.

Open the driver properties, select the Device Options tab, and set the tray option 
(see "Setting Device Options" on page 67).

When printing a document in 

Mac with Acrobat Reader 6.0 or 

higher, colors print incorrectly

The resolution setting in the printer driver may 
not be matched with the one in Acrobat Reader.

Make sure that the resolution setting in your printer driver matches the one in 
Acrobat Reader.
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If you have any comments or questions regarding Samsung products, contact 
the Samsung customer care center.

Country/Region Customer Care Center Website

ALGERIA
0800 100 100 www.samsung.com/

n_africa

ANGOLA 91-726-7864 www.samsung.com

ARGENTINA 0800-333-3733 www.samsung.com.ar

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA
0810-SAMSUNG (7267864, € 
0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN

8000-4726 www.samsung.com/ae 
(English)

www.samsung.com/
ae_ar (Arabic)

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM

02-201-24-18 www.samsung.com/be 
(Dutch)

www.samsung.com/
be_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 051 133 1999 www.samsung.com

BOTSWANA 8007260000 www.samsung.com

BRAZIL

0800-124-421 (Demais cidades e 
regiões)

4004-0000 (Capitais e grandes 
centros)

www.samsung.com.br

BULGARIA 07001 33 11 , share cost tariff www.samsung.com/bg

BURUNDI 200 www.samsung.com

CAMEROON
7095- 0077 www.samsung.com/

africa_fr/

CANADA

1-800-SAMSUNG (726-7864) www.samsung.com/ca 
(English)

www.samsung.com/
ca_fr (French)

CHILE
800-SAMSUNG (726-7864)

[HHP] 02-24828200

www.samsung.com/cl

CHINA 400-810-5858 www.samsung.com

COLOMBIA
01-8000112112

Bogotá: 6001272

www.samsung.com/co

Country/Region Customer Care Center Website



Contact SAMSUNG worldwide

273 Contact SAMSUNG worldwide

COSTA RICA

0-800-507-7267 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

CROATIA 062 SAMSUNG (062 726 786) www.samsung.com/hr

Cote D’ Ivoire
8000 0077 www.samsung.com/

africa_fr/

CYPRUS 8009 4000 only from landline www.samsung.com/gr

CZECH 800-SAMSUNG (800-726786) www.samsung.com

DENMARK 70 70 19 70 www.samsung.com

DOMINICA

1-800-751-2676 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

DRC 499999 www.samsung.com

ECUADOR

1-800-10-7267 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

EGYPT 08000-726786 www.samsung.com

EIRE 0818 717100 www.samsung.com

Country/Region Customer Care Center Website

EL SALVADOR

800-6225 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

ESTONIA 800-7267 www.samsung.com/ee

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com/fr

GERMANY

0180 6 SAMSUNG bzw. 

0180 6 7267864*

 [HHP] 0180 6 M SAMSUNG bzw.

0180 6 67267864* (*0,20 €/Anruf 
aus dem dt. Festnetz, aus dem 
Mobilfunk max. 0,60 €/Anruf)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA
0800-10077

0302-200077

www.samsung.com/
africa_en/

GREECE

80111-SAMSUNG (80111 726 
7864) only from land line

(+30) 210 6897691 from mobile 
and land line

www.samsung.com/gr

Country/Region Customer Care Center Website
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GUATEMALA

1-800-299-0013 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

HONDURAS

800-27919267 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

HONG KONG

(852) 3698-4698 www.samsung.com/hk 
(Chinese)

www.samsung.com/
hk_en (English)

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com/hu

INDIA
1800 3000 8282

1800 266 8282

www.samsung.com/in

INDONESIA
0800-112-8888 (Toll Free) 

021-5699-7777

www.samsung.com/id

IRAN 021-8255 www.samsung.com

ITALIA

800-SAMSUNG (726-7864)

[HHP] 800.Msamsung 
(800.67267864)

www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

Country/Region Customer Care Center Website

JAPAN 0120-327-527 www.samsung.com

JORDAN
800-22273

065777444

www.samsung.com/
Levant (English)

KAZAKHSTAN 8-10-800-500-55-500 (GSM:7799) www.samsung.com

KENYA 0800 545 545 www.samsung.com

KUWAIT

183-2255 (183-CALL) www.samsung.com/ae 
(English)

www.samsung.com/
ae_ar (Arabic)

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA
1800-88-9999 www.samsung.com/

my

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

MOLDOVA 0-800-614-40 www.samsung.com

MONGOLIA +7-800-555-55-55 www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

Country/Region Customer Care Center Website
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MOZAMBIQUE 847267864 / 827267864 www.samsung.com

NAMIBIA 08 197 267 864 www.samsung.com

NIGERIA
0800-726-7864 www.samsung.com/

africa_en/

NETHERLANDS
0900-SAMSUNG (0900-7267864) 
(€ 0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com/nz

NICARAGUA

00-1800-5077267 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

NORWAY 815-56 480 www.samsung.com

OMAN

800-SAMSUNG (726-7864) www.samsung.com/ae 
(English)

www.samsung.com/
ae_ar (Arabic)

PAKISTAN
0800-Samsung (72678) www.samsung.com/

pk/

PANAMA

800-7267 www.samsung.com/
latin (Spanish)

www.samsung.com/
latin_en (English)

Country/Region Customer Care Center Website

PARAGUAY 009 800 542 0001 www.samsung.com.py

PERU

0-800-777-08

Desde celulares por favor llamar 
al número 336 8686

www.samsung.com/pe

PHILIPPINES

1-800-10-7267864 [PLDT]

1-800-8-7267864 [Globe landline 
and Mobile]

02-4222111 [Other landline]

www.samsung.com/ph

POLAND

0 801-1SAMSUNG(172-678) * 

lub +48 22 607-93-33 **

[HHP] 0 801-672-678* lub +48 22 
607-93-33**

* (całkowity koszt połączenia jak 
za 1 impuls według taryfy 
operatora)

** (koszt połączenia według 
taryfy operatora)

www.samsung.com/pl

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

Country/Region Customer Care Center Website
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QATAR

800-2255 (800-CALL) www.samsung.com/ae 
(English)

www.samsung.com/
ae_ar (Arabic)

RWANDA 9999 www.samsung.com

ROMANIA

08008 SAMSUNG (08008 726 
7864)

TOLL FREE No.

www.samsung.com/ro

RUSSIA 800-00-0077 www.samsung.com

SAUDI ARABIA
9200-21230 www.samsung.com/sa 

(Arabic)

SENEGAL
8-800-555-55-55 www.samsung.com/

africa_fr/

SERBIA 011 321 6899 www.samsung.com/rs

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com/sg

SLOVAKIA 0800 - SAMSUNG(0800-726 786) www.samsung.com

SOUTH AFRICA 0860 SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SUDAN 1969 www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

Country/Region Customer Care Center Website

SWITZERLAND

0848-SAMSUNG (7267864, CHF 
0.08/min)

www.samsung.com/ch

www.samsung.com/
ch_fr/

SYRIA
18252273 www.samsung.com/

Levant (English)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999 www.samsung.com/tw

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND
1800-29-3232

02-689-3232

www.samsung.com/th

TRINIDAD & 

TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0330 SAMSUNG (726-7864) www.samsung.com

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com/us

U.S.A

(Mobile Phones)

[HHP] 1-888-987-HELP(4357) www.samsung.com

UGANDA 0800 300 300 www.samsung.com

Country/Region Customer Care Center Website
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UKRAINE

0-800-502-000 www.samsung.com/ua 
(Ukrainian)

www.samsung.com/
ua_ru (Russian)

URUGUAY 000 405 437 33 www.samsung.com

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com/ve

VIETNAM 1 800 588 889 www.samsung.com

ZAMBIA 0211  350370 www.samsung.com

Country/Region Customer Care Center Website
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Glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Mac (1984) and is now 
deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Mac (1984) and is now deprecated by Apple in favor 
of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

Mass storage device (HDD)

Mass storage device (HDD), commonly referred to as a hard drive or hard disk, is 
a non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.
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LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.
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PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can be used 
in a printer, a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.

PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by by a 
combination of heat/pressure from the fuser, causing it to bind to the fibers in 
the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple Mac 
operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.
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WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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